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WELCOME TO MACBENESH

Whether you've ever used a Macintosh before or not, you'll be pleased to know that after
you're through with this tutorial you'll be a veritable fountain of knowledge about this
amazing machine.  Well, you'll be pretty good at using it anyway.

One of the reasons for choosing the Macintosh computer for MacBenesh was the way in
which Macintosh programs work.  Instead of memorizing long commands, or strange
sequences of steps, Macintosh programs put YOU in charge.  Whenever you make a
choice or give a command, you can see the effect on the screen.  The idea of MacBenesh
is to let you think about the Notation, not how to get the computer to do what you want it to.  

In fact, before you know it, you may find yourself getting carried away and becoming a
dreaded "Mac Hack."  Be warned that neither the creators of MacBenesh, nor the writers of
this document take any responsibility, in whole or in part, for any side effects that this tutorial
may incur.  With that last word of caution, let us get started.
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WHAT YOU'LL NEED
Besides some familiarity with the basic elements of Benesh notation, you'll need the
following items:

•  1 Macintosh Plus computer plus an 800K external disk drive.  This is a
separate, rectangular box with a slot that lets you insert another disk.    It
would make life easier if you had a hard disk.  This way you won't need to
switch disks around as often.

•  1    System disk, to start up your computer.

       Macintosh disks are 3.5 inch plastic squares, available in all kinds of designer
colours.  They look just like coasters, except that they have a piece of metal
on the end that you insert into the slot in the Macintosh, or disk drive.  There
is a piece of magnetic tape inside the plastic coating on which information is
recorded, much like a cassette tape.  Because this material is soft, people
who are trying to confuse you call it a "floppy disk," even though anyone
can see that it is not very floppy.

•   1 disk which has the MacBenesh application on it.

If you have all these things, you're basically able to get started. If you also want to be able
to print your score, you will need an ImageWriter or a LaserWriter printer.  The LaserWriter
printer produces better quality printouts, but is also more expensive.  It is likely that one of
these types of printers will already be connected to your Macintosh.
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HOW THIS MANUAL IS ORGANIZED

Part One

You'll notice that Part One of this manual has no section numbers.  It doesn't need numbers
because the order of the sections follows the order of the Macintosh menus.  This makes it
easy for you to find specific information when you use this manual later on.  Unfortunately,
this order isn't always the easiest in which to learn the application.

Most of the time, it's fine just to go through each section in order.  When it isn't quite right,
there will be a note at the beginning of the section to tell you which section to do first, and
another note at the end of the section to remind you to go back to what you've skipped.
When you need more information about some of the more complicated features and
menus, look for it in Part Two.

Part Two

This part takes you step-by step through five of the trickier menus: Do It Yourself
(DIY#(See Do It Yourself)), Locomotion, Phrasing, Counts and Surfacing.  It  also outlines
the way the program automatically spreads or condenses your notation frames, we call this
"formatting,"  and how you can add text to your score.  And finally, it sums up all the
operations you can use to make using the program faster and easier to use.

I'll assume that you've had a basic tour of the Macintosh, and get right down to business b y
introducing you to "The Wonderful World of MacBenesh."
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O.K., SO NOW WHAT DO I DO?

The first thing you have to do is to make sure that you are sitting in front of your favourite
Macintosh.  There is not much point in reading this stuff if you can't try it at the same time.
The next step is probably the most psychologically demanding thing you will have to do
during this tutorial.

If it is not already on, flick the switch on the back, left-hand side of the Macintosh.   There's no
turning back now!  You've turned it on.  Since this is a start for what will hopefully be a
happy lasting relationship,  we now may allow ourselves to refer to this machine as "the
Mac."
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STARTING UP MACBENESH
The way the menus and windows work is exactly the same for MacBenesh as for the
Macintosh Finder and for just about any Macintosh application you may ever use.  So if you
have ever used MacWrite, MacDraw, MacPaint, or MacDraft, you are you well on your way
to being a MacBenesh expert.

If you haven't inserted your MacBenesh disk yet, this is the time to do it.  Insert your
MacBenesh disk into the external disk drive.  If your Mac has a hard disk, you can copy the
MacBenesh application right onto it.

Open the icon that represents MacBenesh by double-clicking it, or by selecting it and
choosing Open from the File menu.

The MacBenesh application is selected.

Your career as a computer dance notator has just begun.
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PART ONE:PART ONE:
THE WONDERFUL WORLD OF MACBENESHTHE WONDERFUL WORLD OF MACBENESH

When you first get into the MacBenesh application (either by selecting and opening the file
from the File menu, or by double clicking the MacBenesh icon), the screen will look
something like this:

The title bar says "Untitled-1."  This is what MacBenesh calls your file until you've named
and saved it yourself.  The menu bar has some familiar names on it.  The Apple , File and
Edit menus are (almost) exactly the same as the ones you saw in the Finder.  Two new
menus are here too:  the Frames and Signs menus.  We'll call these menus "Pull Down"
menus, because (you guessed it) you drag the mouse and pull down the menu to select a
command.
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Try pressing on the names in the menu bar, and compare those that you've seen before
with the ones that are here.  You'll notice that a few new commands are there, like "Save As
Paint" in the File menu.  Remember, a shaded command in MacBenesh menus usually
means that it isn't quite ready to use yet.

On the next row, is a series of icons.  When you select one of these icons, a window will
pop up containing a collection of Benesh signs.  Each icon represents a different family of
signs.  These menus ar called "pop up menus" or "kits."

The long vertical bar at the left is called the "insertion point."  This marks the spot where the
next frame will be added to your score.

On the bottom left-hand side of the window, is a series of icons that you can use to choose
how your notation will look on the screen.  We'll call these "Display Modes."  

The parts of the window that you know and love are all still here:  the scroll arrows which let
you see sections of your score which do not fit on the current screen; the size box which
you used to shrink or expand the size of the window; and that great little close box, that can
let you close the window.  
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THE PULL DOWN MENUS

THE FILE MENU

You've already seen the File menu in the Macintosh Finder.  We'll look at the MacBenesh
File menu a little more closely here.
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New (  N)

This command lets you start a new MacBenesh file.  The initial MacBenesh screen
automatically opens a new file for you, called "Untitled-1."  Try selecting "New."  A new
window called "Untitled-2 " will open on top of the first one.  If you keep doing this you will
notice that you can open as many new files as you could ever want to at one time.  Try
closing some of the windows by using the close box.  If you want to work on a window that
is behind another window, just click anywhere on a piece of the window that is sticking out,
and it will come to the front.  You'll notice that the "active window" has a shaded title bar.  If
the window that you want to choose is completely hidden by another window, use the size
box to shrink the front window, or move it away by dragging it by a spot in the title bar.
Click on the zoom box at the right side of the title bar and watch the window expand to fit
your screen (this only works when all kits are closed).  Click it again and the window goes
back to the size it was.  Try opening, closing, changing window sizes, and moving them
around, until you feel comfortable.

Four "new" windows are open.  If you click on "Untitled-3," it will come to the front.



November 1991 The MacBenesh Manual Page 10

Open... (  O)

This command does not actually open a file for you, but presents you with a window which
lists any MacBenesh files that are on your floppy disk.  You may want to wait to try this until
you have created some MacBenesh files.  If the window does not list any files, then there
are no MacBenesh files on your disk yet.

You'll notice that the titles are in alphabetical order, and that the icon in front of the title
indicates whether it represents a folder or a file.  If your Mac is a "Mac Plus," you will be able
to move to another folder on the same disk (check your Mac Plus manual).

 
The Open... window shows which files are on the disk.

The Macintosh is ready for the possibility that the MacBenesh file that you are looking for is
on another disk.  If you click the Eject box, the disk whose name is above the list of files will
be ejected from the disk drive.  This gives you the chance to insert another disk into the
drive.  

Another possibility that the Mac is anticipating is that your Mac has two disk drives, and that
the MacBenesh file that you need is on the disk in the other drive, or on the hard disk.   If
you click the drive box, the name above the list of files will change to the name of whatever
other disk you have inserted, and the MacBenesh documents on the other disk will appear
in the list.  If you keep clicking the drive box, the various disks in your Mac will appear in the
title box.

When you have found the MacBenesh document that you are looking for, there are two
ways that you can open it.  Being the Mac expert that you are, you can probably guess
them:

1. click the name of the file to select it, and click the open box, or
2. double-click on the name of the file.

The last choice you have is just to cancel, in case you don't find the file that you want, or you
simply changed your mind about opening a file after all.

Close (  W)
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Close whatever file you were working on, by
• choosing the Close command, or
• clicking the window's close box

If you had done some work on your file before closing it, MacBenesh will try to keep you
from wasting time and effort.  A window will appear, giving you three possible answers to
the question: Save changes before closing?

• Yes   
                    In this case, the save window will appear (described further on).

• No
                    In this case, the work you've done since your last save won't be kept.

• Cancel
                    In this case, you just forget about the whole thing and go back to your work.

A LITTLE NOTE:

In this manual we try to keep things in order so that you know where to find
what you are looking for.  However, this doesn't mean that you have to read it
in this order.  You now know enough to start a MacBenesh file, so if you want
to skip to The Frames menu section, and find out how to save, print and edit
later, go ahead and do that!

Save  (  S)

Saving your MacBenesh file (or any computer file, for that matter) is the most important
thing you do with it.  Before you've saved it, it's there on the screen, but the Mac won't ever
be able to remember it and open it again.  It is a good idea to save your file every once in
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awhile, so that if you erase something you didn't want to, or if anything else goes wrong,
you always have the previous version of your file.

(Every computer manual contains the following advice, which most users ignore until the
program crashes and they lose their last ten hours of work.  But, here it is anyway...)

Warning!  The authors of this manual strongly recommend that you save your work every
ten minutes since MacBenesh is still under development and may contain bugs.  Failure to
do so may result in loss of work caused by program crashes.  

There are two possibilities when you save a document: either this is the first time you have
ever saved it, or you have already saved it at least once.

If you have never saved it, then the Mac lets you choose a name for your new
document.  You'll notice that the cursor is blinking in the name box, and the Save box is
shaded, because you can't save it before you tell the Mac what you want to call it!

Saving "Monica's Score" on "My disk."
If you want to save the document on another disk, click the Eject box, and insert another
disk.   If you want to save it on the disk in the other drive, or on the hard disk, click the Drive
box.

Otherwise, type the name that you would like to call your document in the box.  You'll notice
that a list of the document names that you have already used appears in the Save window.
This is to remind you of what these names are, so that you know not to use those names
again, unless of course, you want your new document to replace the previous document of
the same name.  
Now the Save box should not be shaded anymore, so click it, or hit the Return key.  Your
document will be saved on the disk whose name appears above the list of files, and the
Save window will disappear.

If you have already saved it at least once, and you just want to update your document,
then your file will automatically be saved under the name that you gave it the last time that
you saved it.

Save As...
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If you made changes to a MacBenesh document, but you still want a copy of the file the
way it was before the changes, use the Save As...  command.  This is just like saving a
document for the first time, and the same Save window appears.  Just type a different
name as the current file name to save the file, and the previous file will be untouched.

Save As Paint...
Normally, when you save your document it will be a MacBenesh file.  However, the
program gives you the option of saving your MacBenesh document as a MacPaint file.  B y
choosing the Save as Paint command, you can save up to 7 staves of notation as one
MacPaint file.  If you have a MacPaint application on your disk, you will be able to edit your
document using the many tools available in MacPaint.  For example, you may want to cut
signs from your score and paste them into word-processing documents.  Just remember
that lines will print thicker and curves less smooth when you go through MacPaint, since it is a
'bitmap" application.  Save your document as a MacPaint file, open it from the MacPaint
application, and happy painting.

Saving the MacPaint file "Monica's Score.paint"
The old Save Window pops up again, and presents you with the choice of calling your
document "score.paint."  If you like that name, just click the Save box.  If not, hit the delete
key, and retype whatever name you like.
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Revert to Saved
If you made changes to a MacBenesh document, and you decide you don't want those
changes and you would rather go back to the way it was before the changes, use the
Revert to Saved command.  This restores the file as it was the last time you saved it.  If
you choose it, any changes you made since then will vanish into hyperspace.

Page Setup...
This command lets you set up several options for printing.  You should invoke this
command whenever you install or change the printer using the Chooser desk accessory.  In
the following examples, we have just selected a LaserWriter.   You can use any other
printer, for example, an ImageWriter.  However, if you do, the Page Setup and Print dialog
boxes will look slightly different.  When you invoke the Page Setup command, the
following dialog box appears:

It lets you specify the paper size, and a variety of other options. You can print the score at
actual size (100%), at a magnification (say 200%), or at a reduction (say 50%).  You can
print the score in portrait (normal) or landscape (rotated) orientation.  You can select various
printer effects.  You can also print the score using several other options.  The following
dialog box will appear if you click on the Options button:

Try clicking on the check boxes to see the affect of the options (cute, huh!).  When you are
finished, click on the OK button to return to Page Setup.

If you require further explanation of the Page Setup options, click on the Help button to get
the following dialog box:
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Normally, you will never have to change the defaults (basic settings) of the Page Setup
dialog box since they are chosen to produce the printed result you would expect.
However, if you want to produce a special effect, try experimenting with the numerous
options.
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Page Options

Unfortunately, this menu is not working yet.  Right and left margins are currently set at 0.5
inch (1.0 cm).  We've decided on the following defaults: margins will be measured in inches,
the header and footer will appear on the first page, page number type will be arabic
numerals, page numbers will start at "1," and pages will be printed (not page/total pages).

Eventually you'll be able to change the defaults by typing new values in the boxes or
clicking on other options.
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Print... (  P)

The Print command is used to send the score to the printer.  The following will appear when
you invoke this command, if you have a LaserWriter hooked up and running (remember to
select which printer you want through the Chooser in the Apple  menu):

This dialog box lets you specify the number of copies you want and the range of pages to
print (the entire score, or part of it).  If you want further explanation, click on the Help button
and (you guessed it!) the following dialog box will appear:

Using a LaserWriter gives you good quality printouts with fine lines and smooth curves.
You can get draft quality printouts with the ImageWriter.  Just make sure you select the
printer and port you want through the Chooser in the Apple  menu.
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Quit (  Q)

This command gets you out of MacBenesh, and back to the Finder menu.  MacBenesh will
check to see if you've saved your file, the same way as when you choose the Close
command.

A LITTLE NOTE:

Since this tutorial follows the order of the menu bars, so that it is easier to
find things, we will explain the Edit menu before the Frames menu.
Unfortunately, this is not the easiest order to learn things, so if you haven't
read the Frames menu section yet, this may be a good time to do that, and
to come back to the Edit menu section later.
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THE EDIT MENU

If you press down the Edit menu, you will see a screen with the following set of commands:

Undo (  Z)

The Undo command lets you "undo" your most recent action.  Unfortunately, it doesn't work
in MacBenesh yet, but it can be used with desk accessories.

Cut (  X)

You can use the Cut command to either get rid of or move frames.  After you've selected
the frames that you want to cut, so that they are surrounded by boxes, just choose "Cut"
from the Edit menu.   Read the section on "Selecting Frames" to find out how to indicate
which frames are to be cut.

Never fear! The frames that were just cut are not gone forever.  They are in the "clipboard."
This is a file that you can use to move pieces of notation within or between MacBenesh
files, or even to other files like MacWrite documents.  Check out Paste below, for details.

Copy (  C)

Copy is used if you want to (you guessed it!) copy frames within or between MacBenesh
files, or to other files like MacWrite documents.  It works just like Cut, by putting the selected
frames in the clipboard, only the frames don't disappear after you choose Copy.   To put
the frames in the place where you want them, use...

Paste (  V)

Just as the name implies, "Paste" takes the frames of notation in the clipboard, and "pastes"
them wherever you want.  Whatever you selected in your last "Cut" or Copy"  is what is in
your clipboard.  To place it in your document, click a spot between the two frames in which
you want the selection to appear, so that the insertion point is at that place.  Now choose
"Paste" from the Edit menu, and voilà, one pasted clipboard!

You can keep pasting this clipboard as many times as you want, until you do your next
"Cut" or "Copy."  When you make a new selection to be "cut" or "copied," the old one will
disappear from the clipboard.  If you want to paste the clipboard to another MacBenesh
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document, or to another type of file, like a MacWrite word processing file, just close your
MacBenesh file, quit MacBenesh if your other file is a different type, open the file you want
the clipboard in, and choose Paste from the Edit menu.

Clear
If you want to get rid of some frames without changing the contents of the clipboard, then
select the frames that you want to get rid of, and choose Clear from the Edit menu.  
Make sure that you really want to get rid of those frames though, because you can't get
them back since they are not put into the clipboard.

A shortcut for getting rid of the frames you've selected is hitting the delete key.  This does
exactly the same thing as the Clear command.

Show Clipboard
If you forget just what it was that you last "Cut" or "Copied," choose the Show Clipboard
command in the Edit menu, and a window will appear, showing you the contents of your
clipboard.

That takes care of most of the boring details.   Now, lets get into "the right frame of mind."
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THE FRAMES MENU
When you use MacBenesh you begin with a blank page and add new frames as you need
them.  A MacBenesh score consists of a string of frames, something like a string of beads
on a thread.  You can add and delete frames anywhere in the score, or move them around.
Each frame carries with it a portion of the 5-line stave and some notation.  Frames are
automatically arranged into staves across the page.  When you make insertions or
deletions, each frame may shift its position or hop from one stave to the next.

Add
There are two ways in which you can add a new frame or frames:

1. Select Add from the Frames  menu.
2. Hit the space bar on the keyboard.  Depress the bar once to add a single frame,

or hold it down and add several.  Frames are added until you release the bar.

Now the screen looks something like this (depending on how many frames you added):

The last  frame added is surrounded by a rectangular box: it is "selected."
Erase
By choosing the Erase command, you can simply get rid of all of the signs in the selected
frame or frames, without taking away the frame itself.
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If you want to get rid of one sign at a time, just drag it out of the stave area until you get a
"thumbs down" icon (  ), then release the mouse button.  You can get rid of several signs
in a frame by selecting them, grouping them, and then dragging the group out of the stave
area. (Find out more about  "selecting" and "grouping" signs in the section on the Signs
menu.)

Select All
As we've seen before, MacBenesh works just like most Macintosh applications: first you
select what you want to work on (icon, menu command, and so on), and then you select
what you want to do.  For this reason, we need a way to select the frames that we want to
work on.  You'll notice that the last frame you added (with any of the previous methods) has
a box around it.  This means that it is "selected."  Try adding another frame by hitting the
space bar; now the new frame has a box around it, and the first box is gone.  The last frame
to be created is always selected.

There are two ways to select a frame or frames when it already exists:

1. Double click on the left side of the frame to move the insertion point in front of the frame
that you want to select.  Move the cursor to the right side of that frame, hold down the
Shift  key, and double click again.  The frame is highlighted.  You can use the same
method to select a series of frames.

or

2. Double click at one side of the frame, drag across the frame or series of frames, and
release the mouse button at the far end of the frame or frames.

If you want to select all of the frames in a file, just choose the Select All command in the
Frames menu.

Now that we know how to tell the Mac what we want to work on, let's see what we can tell it
to do.
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Format
When a frame is first created it is 16 mm wide: this gives the notator room to position  signs.
In a finished score, however, each frame is just wide enough for the notation it contains.  The
Format command adjusts each selected frame to its "proper" width, based on the signs
within it.  This usually makes the frames narrower.

One "selected" frame: 16mm. wide."

The Format command narrows the selected frame to the width of any body signs in it (we'll
talk more about this later, in PART TWO, in the section on Formatting in MacBenesh).
There are three ways to Format a selected frame:

1. Select the Format command from the Frames menu,
2. Type F,

or
3. Click in the "format box" at the top right of the frame.

Formatting a frame by clicking the "format box."
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Unformat
The Unformat command sets the width of each selected frame back to 16 mm.  There are
three ways to Unformat a formatted frame:

1. Select the Unformat command from the Frames menu,
2. Type U,

or
3. Click in the "format box" at the top right of the frame.

No Padding
This command can be used to remove all padding automatically added around selected
frames, if there are no signs in the frame edge (excluding bar lines).  When No Padding is
selected, the stave width is equal to the widths of all frames in a stave and is not adjusted to
fill the page width less margins.  At present, No Padding does not affect the width of a
frame when it is copied.

Re-Pad
To restore the automatic adjustment of frame-edge area to selected frames, select
the Re-Pad command from the Frames menu.

A LITTLE NOTE:

To learn about how MacBenesh automatically formats frames and spaces
them evenly along the width of the stave, read Formatting in MacBenesh in
PART TWO.
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THE SIGNS MENU

The commands in the Signs menu .

When you start positioning signs on the stave, you may want to change the size, shape or
placement of some of them.  The commands found in the Signs menu work on certain signs
which MacBenesh recognizes as shapes, lines and curves, but not on signs it considers
"bitmaps."  You may want to skip this section until you get some practice using the pop up
menus or "kits" containing Benesh signs, especially the Do It Yourself (DIY) menu (more on
this later).  In the meantime, here's a summary of the operations you can perform once you
have some signs on the stave.  First you have to select a sign or signs by depressing the
Command key ( ) while you click on a sign or drag across the sign(s).  You'll know it's
selected if it "twinkles."  Then, depending on the sign(s), you can:

Reshape ( R): change the shape of a spline, that is, change its curvature.

Resize ( E): elongate a sign, that is, change its height and/or width.

Group ( G): treat more than one sign as a single sign.  This only works for signs in
the same frame.

Ungroup: ungroup a group of signs.

Mirror ( M): put a mirror image of the sign(s) on the other side of the frame, the
same distance from its centre line.

Flip Horizontal: redraw a sign(s) in the same place but flipped left to right (the
sign becomes a mirror image of itself).

Flip Vertical: redraw the sign(s) upside down.
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Rotate: redraw the sign(s) rotated 90° clockwise.

Move 1 Pixel Up: move a sign(s) 1 pixel up.  This can also be done via the
arrow key (  ).

Move 1 Pixel Down: move a sign(s) 1 pixel down.  This can also be done via
the arrow key (  ).

Move 1 Pixel Left:  move a sign(s) 1 pixel left.  This can also be done via the
arrow key ( ).

Move 1 Pixel Right: move a sign(s) 1 pixel right.  This can also be done via the
arrow key ( ).

Remember to select the sign before choosing one of these commands.  If a sign
or signs can't be edited with the operation you just selected, you'll see a dialogue
box asking whether you want to continue or to cancel the operation.  A sign stays
selected (twinkles) after each operation so that you can chose more operations.
When you are finished editing the sign, click anywhere off that sign (it stops
twinkling).

A word of warning: you may see a "phantom" line or curve when you resize,
reshape or mirror a sign.  It should disappear when the screen redraws itself.  Just
one more bug to be hunted and destroyed!

A LITTLE NOTE:

If you skipped the Edit menu and went straight to this section, this is a
good time to go back and read the Edit menu section.
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THE FONT MENU

The commands in the Font menu .

You may have noticed that the word "Font" on the menu bar was shaded when you
opened MacBenesh.  That's because it isn't needed until you want to type something on
your score.  So first you'll have to learn how to choose the mode that lets you type.  You'll
probably want to skip this section and come back to it after you read about the Document
menu.  

When you are ready to use the keyboard to add text, you can choose a font's Style, its
Size and its Type with commands found in the Font menu.  You'll notice that Clear Text is
shaded since we haven't  ironed the kinks out yet.  

For a step-by-step introduction to the Font and Document menus, turn to the section called
Adding Text  to Your Score, in PART TWO.
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THE DOCUMENT MENU

The commands in the Document menu .

You use the commands in the Document menu to tell the computer that you want to use
your keyboard to type words and letters on your score or at the top and bottom of each
page.

You'll probably want to type a word for musical tempo or quality at the start of the score.
Just select FreeText or type T ("T" for text), and your cursor becomes an I-beam ( ).
Move the I-beam where you want to type, then click to get a blinking insertion point.
Whatever you type will go right after that point.  You just type as you would in any other
application.  But MacBenesh is a bit different because it has to hook the string of letters or
numbers (we call this a "text string") to a particular place in a frame.  And that hook stays the
same, even when frames near it are added, deleted, or formatted (see Formatting in
MacBenesh, PART TWO).

You can also type in special-purpose areas at the top and bottom of the page, areas for
the Title, Header and Footer.  You'll probably want to put information about the score's title,
choreography and music in the Title area.  It will appear near the top of the first page of the
score.  Anything you put in the Header and Footer will appear at the top and bottom of
each page of the score.
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The empty Title window .

When you select a command for Title, Header or Footer, an empty window pops up and
your cursor becomes an I-beam ( ).  Just click to set the height of your insertion point (it is
Aligned Left by default).  Then you can type a text string, or click on one of the icons at the
bottom left of the window. From left to right they are: date, time, page number and
copyright notice.  
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A Footer window  containing copyright information.

Notice that the words File, Frames and Signs are shaded in the Menu bar when FreeText is
selected.  That's because you are using your keyboard and mouse to create text, not to
add signs or move them, etc.  To move any TextRecord up or down, deselect FreeText in
the Document menu (or type T) and you get a pointer cursor again.  Just drag the
TextRecord up or down.  To change its alignment from left to centre or right, you must select
FreeText, click on the TextRecord, then select a new alignment in the Document menu.  

To start working on your score again, you must close the Title, Header or Footer window b y
clicking on its close box at the left of the title bar or deselecting it from the Document menu.  

When FreeText is selected, you'll notice that the word Font is no longer shaded, and that it's
pull down menu appears when you point at it and hold down the mouse button.  You use
the commands in the Font and Document menus to change the style, size, font and
alignment of anything you type.  For a step-by-step introduction, turn to the section called
Adding Text  to Your Score, in PART TWO.
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THE POP UP MENUS or "KITS"

THE MACBENESH ICONS
Underneath the menu bar, is a row of icons (we'll call it the "kit bar") which represent families
of Benesh signs.  These icons let you select and place Benesh signs on the staves.  All of
the icons work the same way, even though some of them have some extra features to help
make your job easier.  Let's look at each icon and its window, starting at the left of the kit bar.  

You should recognize most of the icons as Benesh signs.  They represent the signs for
Musical Scoring, Body Positions, Staging (body direction#(See Direction), location on the
stage, and travel ) and Do It Yourself signs (sketching lines, curves, etc.).

                                                        The MacBenesh icons.

We'll be looking at all of these from left to right as they appear on the kit bar.
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How the Icons Work
Each icon has a little window we call a pop up menu or "kit."  Kits let you choose or create
and position Benesh signs.  To open these windows, place the pointer on top of the icon
showing the family of signs that you want, and hold down the mouse button.  A dotted
frame will appear, representing the outline of your window.  Still holding down the button,
drag the box anywhere you like on the screen.  When you let go of the button, the icon's
menu window will "pop up" in the dotted outline.  Try it with a couple of icons.  

Here's what the screen looks like after you choose the Numerals icon and hold the mouse
button down :

Here's how it looks after you drag it over to the other side of the screen and let go of the
mouse button:

You can open as many icon windows at the same time, as will fit on the screen.  If you want
to keep a window open after choosing another one, just make sure that the new window
doesn't overlap the old one.

Here's an example of a screen with three open icon windows:
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As you can see, things tend to get messy if you keep too many windows open.  There are
two ways to close an icon window:

1. click the close box on the top left-hand side of the window,

or

2. just open a new window which overlaps the old one, and the old window will
disappear.
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Dragging the new window to overlap the old ones.

                              The windows which were overlapped are closed.

Try experimenting with opening and closing a couple of icon windows.
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MUSICAL SCORING

Numerals (  )
Press the Numerals icon, and drag the Numerals window to a convenient place on the
screen.  Numerals act just like well behaved pop up menu signs.  Add an empty frame,
then try dragging a Numeral Sign onto the stave.

You'll notice that when the pointer is in a part of the window where there is no stave, it gives
you the "thumbs down" (  ).  If you let go of the button while you see the  "thumbs
down" icon, the sign will just disappear.  You can get another one from a pop up menu.
The "thumbs down" disappears as soon as you move the pointer onto the stave.

Dragging a Numerals sign onto the stave, through a "thumbs down" area.

Try placing a sign within the frame boundary (inside the rectangular bounding box) or in the
edge of the frame (outside the box).  When you want to use a numeral to show the time
signature at the start of your score, position it in the left frame edge and watch the frame
edge area expand to contain the numeral.  When you want to use a numeral following an
end repeat sign, position it in the left frame edge of the following frame.
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The Numerals sign "snaps" to a line.

To help any shaky hand, Numeral signs "snap" to the second, third or fourth stave line.  To
move a Numeral sign slightly up or down away from the line, press the Shift key as you
drag the sign.

Once a sign has been placed in a frame or frame edge, you can pick it up and move it to
another position. Try it.  If you hold down the Option key on the Mac keyboard while picking
up a sign, you will pick up a copy of the sign without disturbing the original.

You can put signs on the desktop as well as in a score.  The desktop is the white area that
lies underneath all of the windows.  It can be used as a temporary storage place for signs
that you have constructed and want to use in several places in your score.

Rhythm (  )

Now position the pointer on top of the Rhythm icon, and drag the dotted outline so that it
overlaps the previous window.  The previous window magically disappears, and the
Rhythm window stays open.

The basic rhythm signs can be used as is.  They "snap" to the centre of a frame, but you
decide how high to position them.  If you need to move a rhythm sign off-centre, just hold
down the Shift key as you drag the sign.  For grace notes, click the crossed mode box.
(You'll have to add your own curved line by using the curve mode in the Phrasing or Do It
Yourself menu.)  To notate dotted rhythm signs, drag the dot in the menu onto the
appropriate spot on the stave.
Bar Lines (  )
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Choose from our wide selection of Bar Lines, something to please every notator:   regular,
dotted, double, or final double bar lines.  These signs "snap" onto the stave between the
top and the bottom stave lines.  When you place a bar line outside the rectangular
bounding box near the right edge of a frame, it automatically snaps flush against that frame
edge so that you don't waste time positioning it.  The final double bar line marks the end of
a stave: any frame added to its right is automatically positioned on the stave below.

Repeat Signs (  )

  

Repeat signs "snap" onto the stave like bar lines.  Just drag the sign you want from the top
of the menu.  You'll notice that there are three sizes of start repeat signs for nested repeats.
The top line of mode boxes allows you to choose solid repeats (the default setting), fully
dotted repeats, and partially dotted repeats.  The bottom line of mode boxes represents
same side (default), other side, alternating sides, and reverse side repeats.  The far right
mode boxes let you choose single dotted or double dotted signs, for qualifying nested
repeats.   

It's best to select a frame (you'll see the rectangular bounding box) before you try to
position a repeat sign so that you'll see whether you are placing it inside the frame or in the
frame edge.  When you place an end repeat sign in the right frame-edge area, it snaps to
the right edge of the frame.  When you place a start repeat sign in the left frame-edge area
it snaps to the left edge of the frame.  A word of advice about creating nested start repeat
signs.  Try positioning the largest sign first.  Then place the smaller sign inside the
rectangular bounding box and depress the Shift key as you drag the sign into the frame
edge, flush against the larger repeat sign.  It may take a bit of practice, but you'll soon get
the hang of it.

Counts (  )
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The Counts menu is used for creating dancers' counts, musical counts and section headings.
First click on one of the top three boxes to get a sign shape, then click on the letters and
numbers in the boxes below and watch them appear inside the shape.  The shape you
picked automatically stretches to contain the signs as you "type" them.  To get superscript
numbers or lowercase letters, just click on the heavily bounded boxes at the right side.
Click again to restore plain numbers and uppercase letters.  To add a space, click on the
empty box to the left of the dash.  When the sign you want appears at the top of the
menu, you can drag it right onto the stave.

If you pick the wrong shape, just click on the highlighted shape box and that shape
disappears, or click on another shape.  If you click the wrong letter or number, just click on the
eraser and the last number or letter you typed disappears.  To erase everything, depress
the Shift key as you click on the eraser.

You can also type numbers and letters without a bounding shape, and drag them onto the
stave where you can combine them with other sign (like lines, curves and shapes that you
create with the Do It Yourself menu).

You can take a step-by-step tour of this menu in PART TWO.



November 1991 The MacBenesh Manual Page 39

Phrasing ( )

The Phrasing menu lets you create nine types of bows.  When you click on the shape you
want, you'll see that the cursor becomes a cross-hair.  For the top six bows, just move the
cross-hair to the place you want the bow to begin, depress the mouse button, and drag the
cursor upwards and to the right until the bow is the right shape.  For the others, start where
you want the bow to begin, then drag downward and to the right.  You can move the cursor
back and forth or up and down until you're satisfied, then release the button, and voilà!  You
can even start a bow on one stave line and finish it on the next.  

Another way to create one of these bows is to choose a shape, position the cross-hair at
the start of the curve and click, then move to where you want the bow to end and click again.
With this method, your second click also defines the highest point on the curve.  If it is the
same height as your first click , the bow will be flat.  Eventually these signs will be editable
through the Signs menu.  For now, if you don't like the sign you created, it may be just as
fast to drag it off the stave and try again.

To help you start and end Phrasing bows right at frame edges, read the section describing
Dotted Frame Boundary Mode.

By the way, the signs at the bottom of the menu can be dragged directly onto the stave.

You can take a step-by-step tour of this menu in PART TWO.
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BODY POSITIONS

Head/Torso

Press the Head/Torso icon, and drag the Head/Torso window to a convenient place on the
screen.  The top row contains the actual signs that you will select and drag onto the stave.
These signs show the different degrees of tilt.

Since it would have been really confusing to put the three hundred odd possible
head#(See Head/Torso)/torso#(See Head/Torso) positions in the window, you will use
the bottom two rows to "make" the position that you want.  The second row shows bending
forward or back, like lowering the head toward the breastbone or raising it toward the spine,
or flexing and hyperextending the spine.  

You'll notice that the middle box in both the second and third row are initially selected when
you first open the window.  These default settings show no bends or turns.

We'll go through an example for a head position, but it works the same way for upper torso
and hip positions.  Click the box in which the short vertical line best represents the location
of the chin.  Now each of the signs in the top row show this position for the chin.  To show
rotations or turns, click the box which best shows the degree of turn.  The greater the turn,
the longer the stroke representing the chin.

Now choose the sign in the top row that best represents the tilt of the head or torso b y
placing the pointer on it.  Press down on the mouse button, and drag the sign onto the
stave.
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The sign "snaps" into place.

MacBenesh will try to help you place your sign accurately.  Since it doesn't make sense for
the head or torso sign to be placed across a stave line, the sign will automatically "snap" into
position between the nearest two lines where you placed it.  MacBenesh will also snap the
bottom of your head or torso sign to the centre line of the frame.  This will help you create
schematic recordings.

If you want to move a sign slightly right/left or up/down, press the Shift key while you drag
the sign.  You'll need to learn how to "shift" Head/Torso signs in order to create pictorial
recordings.  Or you can draw them with the straight line mode from the Do It Yourself menu.

Try creating a different Head/Torso sign, and placing it at different positions in the stave so
that you can watch it snap in place.
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Limbs

The signs in the Limbs menu include your basic extremity signs, and the ad lib sign, that
you can drag anywhere onto a stave.  This works the same way as you saw in the
Head/Torso window.  

So what's the catch?  Well, there's just one little thing.  It's those crossover signs.
Fortunately, they're pretty easy to master too.  If the sign you need should be qualified b y
a vertical or horizontal crossover sign, or both, just click the appropriate box (/ or \),  and all
of the signs in the window will be crossed.  

The Limbs menu, with the vertical crossover mode selected.

If you click on one of the boxes again, the signs will be "uncrossed," kind of like an "off / on"
switch.  

Press the space bar to add another frame, and try positioning a sign inside or outside the
rectangular bounding box.  MacBenesh will only allow you to put a Limb sign (or any Body
Position sign) within a frame boundary.  If you try to put one in the frame edge area, you'll
see the bounding rectangle expand to contain it.  This is part of the way MacBenesh is
programmed to "format" frames and spread them evenly along the stave width.  You may
be interested in checking the section on the Formatting in MacBenesh (PART TWO) to
understand how placing signs works in MacBenesh.

Unfortunately, MacBenesh isn't smart enough to know about human anatomy, so if you
notate someone with three arms and four legs, MacBenesh won't rescue you.  However,
even as we speak, some poor computer person is slowly and painfully trying to explain to
MacBenesh about the birds and the bees.
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Two Feet Together

This one is a little more complicated.  The pop up window displays five columns of feet
position signs.  From left to right, these are: fifth and third with the left foot in the back, first,
and third and fifth with the right foot in the back.  Each of these five columns has four rows.
The top row represents static positions, the following two are one foot closing positions,
and the last row is two feet closing positions.  These signs are ready to be dragged off the
window, just like all other types of windows, but you may need to use one or more of the
mode boxes on the bottom.  

The four boxes together represent Cou-de-Pied signs.  The next box provides the basic
Bourrée signs.  Notice that when you click this box, the ad lib sign appears underneath the
middle column.

The bottom row of six boxes are options for showing the feet together in front of or behind
the coronal plane, for showing the heels at differing heights from the floor, or feet flexed.

Create the appropriate sign, and drag it onto the stave.
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Click the boxes which are appropriate for the position that you are trying to describe, and
drag the correct foot positions off the window and onto the stave.  Remember that the
mode boxes are binary, so that you can "choose" and "unchoose" a mode by successively
clicking the box.  

Contacts, Supports, Wrists

          

     

No funny business here.  Just pop up the windows and drag the signs you need onto the
stave.  The implementation of the Supported and Supporting menus has made the
Support menu redundant, but for the time being we chose to leave it in (we didn't want to
hurt its feelings).   
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Surfacing ( )

The Surfacing menu lets you create signs for Body Zoning and Surfacing.  It works a bit like
the Counts menu.   Click on the letters, numbers and ticks, etc. in the boxes near the
bottom of the menu, and watch them appear at the top centre of the menu and also inside
the circular shapes.  The shapes automatically stretch to contain the signs you "type."  You
can type an empty space by clicking on the empty box to the left of the eraser.  If you click
the wrong letter, etc., just click on the eraser and the last thing you typed disappears.  To
erase everything you typed, depress the Shift key as you click on the eraser.  If you want
circular signs for upper and lower surfaces, click on the box beside the highlighted icon and
watch all the signs above change.  To restore the original shapes, click on their icon.

You can drag any of the signs from the top of the menu onto the stave where you can
combine them with other signs.  For example, you'll need to use Surfacing signs along with
lines, curves and shapes from the Do It Yourself menu to create finger notation and body
skimming.  If you don't like the way the signs are automatically spaced (computers
sometimes make very bad aesthetic judgements), drag each individual sign from the centre
of the menu, arrange them on the stave, then select them and group them (see DIY menu).

You can take a step-by-step tour of this menu in PART TWO.

A LITTLE NOTE:

These menus include most of the commonly used Benesh
signs for body positions, but not all.  Eventually those hard
working MacBenesh folk will be expanding them to include
more and more combinations.  In the meantime, you can be
creative, e.g., use some of the wrist signs as toe caps or create
signs with the Do It Yourself menu.

STAGING
Direction (  )
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Another easy one; choose your sign and bring it onto the stave.

Direction/Turn (  )   
Do you get the feeling of déjà vu?  We thought it might be handy to have the small
direction menu#(See Direction) for those times when you only need a static direction
sign#(See Direction).  But should  you want to change direction#(See Direction/Turn)...

The top two rows of the Direction#(See Direction/Turn)/Turn#(See Direction/Turn)pop up
window display sixteen draggable turn signs.  In default mode, the starting direction is to the
audience, the direction of turn is clockwise and the amount of turn is from static to 1-7/8.   The
third row contains draggable duration brackets, addition brackets, and three alternative turn
signs for 1-5/8, 1-3/4 and 1-7/8 (you can't accuse us of not giving you a choice!).  

The next two rows are option boxes with the default modes highlighted.  The top row of
options change the starting direction of all nineteen turn signs.  The five options on the left of
the bottom row, change the amount of turn and the two options on the right, change the
direction of turn.  

Though it may seem a tad complicated, it isn't really.  Just click a few of the options and
watch what happens to the draggable signs.  You'll soon get the knack of it, we promise.
Once the sign you want appears, just drag it onto the stave.
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Location (  )

The rectangle in the middle of the window represents the stage.  Just place the pointer at
the spot where the dancer is located on the stage, and click.  The appropriate location sign
will appear underneath the rectangle.  For basic stage locations, click on the appropriate box
above the stage, and an unqualified  location sign will appear.  If you select the box at the
bottom of the window which contains a dotted "left wing", all the signs will become dotted
"ad lib" stage location signs, until you deselect it.  Ad lib location signs are useful when you
don't want to be specific about where you are on the stage.    

To get rid of a location sign that you have chosen, just click the same spot or box again, and
the sign will disappear.  By clicking between two basic stage locations, or on more than one
spot or box, you can create composite stage location signs.  Click the eraser and all location
signs disappear.

Creating a composite sign, by clicking  between two basic stage locations.

When you are ready to drag your sign onto the stave, everything  below the stage will
move together.  If you do not want a composite location sign, move the location signs onto
the stave one at a time.  Remember, "What you see is what you drag" (??!)
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Travel (   )

The Travel pop up window displays the eight basic travel signs in the default mode:  lines
of travel when the dancer faces the audience.  When you click on another direction sign, all of
the eight signs change to incorporate this new direction.  These are the "general" travel
signs.  To get miniature "single action" travel signs, just click on the small travel sign box in
the bottom right of the window.  

On the centre bottom of the window, are duration brackets that you can drag onto the stave
as they are.  On the bottom left, is a mode which is not ready to use yet, but will allow you
to notate ad lib travel signs.   To create curved travel signs, you'll have to use the Do It
Yourself menu.  Let's "hop" along to the next menu...

Hop (  )

Here we are with nine draggable hop signs and four option boxes, two of which are
selected for a single hop with a level sign.  Only one of the two boxes on the left can be
selected at any one time.  (Let's face it, you can't be hopping on one foot at the same time
you are bouncing on two feet.)  If you click on the third option box it will be deselected and
the level sign will disappear and you will be left with just a plain hop sign.  We thought you
might need this in case you wanted to get fancy and hop on pointe or something equally
painful.  

You never know when you may want to skim through things, so click on the fourth option
box.  You now have either skimmed hop or skimmed bounce signs depending on which of
the first two options you selected.  
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Locomotion (  )

You can use the Locomotion menu to create step, jump and slide lines.  The top row
contains mode boxes for low steps left, in place and right, and one for steps from a lifted
foot.  The next row has mode boxes for jumps left, in place and right. The bottom mode
boxes are for straight and circular slides.  Choose the type of locomotion line you want to
create by clicking on any of these boxes, and watch your cursor become a cross-hair.  You
create these lines almost the same way as phrasing bows.

Just move the cross-hair to the place you want the line to begin, depress the mouse
button, and drag the cursor  to the right until the line is the right shape.  You can move the
cursor back and forth or up and down until you're satisfied, then release the button, and
voilà!  You can even start a line on one stave line and finish it on the next, but procede
slowly (remember the strange happenings described for the Phrasing menu!).  

Another way to create one of these lines is to position the cross-hair where you want it to
start, click, then move it to where you want the line to end and click again.  For step lines,
your first click defines the height of the line,  For jump lines, there is a set depth.  But for
circular slide lines, your second click also defines the highest or lowest point on the curve.  If
it is the same height as your first click , the circular slide line will look like a straight slide line!   

These signs are editable through the Signs menu (after electing the sign, choose Resize or
type E).  But sometimes it is just as fast to drag the line off the stave and try again.

The box at the bottom right of the menu lets you select skimmed jump or slide lines.  The
six boxes at the centre right of the menu apply qualifications to the step, jump and slide line
mode boxes.  Only semantically sensible options are presented.  Try clicking various
combinations of qualifications and skimming.  Watch the mode boxes change to show you
what type of line you can create with each selection.

For more details, take a step-by-step tour of this menu in PART TWO.
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THE DIY MENU (  )

Now that you've made it this far, nothing can stop you, right?  Right.  Well, this one isn't so
bad once you get used to it.

The Do It Yourself menu (DIY) lets you make signs you can't find in other menus.  It's
especially useful for drawing movement lines, and of course for scrawling your name on
your masterpiece of a score.  

There are several features in the DIY menu, so we'll just run through them one at a time.
You can take a more detailed tour of this menu in PART TWO.

Draggable Signs

The simplest signs in this menu are the draggable signs in the middle.  These look like
many other signs found in pop up menus, but they are quite different.  Other menus contain
bitmapped signs that can't be edited by the operations in the Signs menu.   DIY signs can
be.  Just drag one on to the stave, select it ( -click) and explore the many metamorphoses
you can create.

The shapes near the top of the menu are also draggable.   Most of the Sign menu
operations work on them too (but they can't be reshaped).  These signs are a bit more
complicated in that they come in different flavours: white (the default setting), empty or
black.  

To get an empty or black circle, square, diamond or triangle, you have to click on the mode
box to their right before you drag the shape onto the stave.

All draggable signs come in different line thickness.  Read on....
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Line Thickness

You can choose the thickness of solid or dotted lines with the line thickness settings:

When you open this menu you'll see that the centre box is highlighted.  With this setting, all
draggable signs and any curved or straight line you draw will be the thickness of a
movement line.  To get draggable signs or draw lines as thin as stave lines, click on the
thinnest line setting.  For signs and lines as thick as basic signs click on the thickest setting.
Unfortunately, all line thicknesses look the same on the Mac screen, except in Magnify
Mode (which we'll learn about soon, in the section on Display Modes).  On printouts from
the ImageWriter, all lines come out as thick as basic signs, but high resolution printers like the
LaserWriter print thinner lines.  Any of these thickness can be drawn as dotted lines.  Just
remember to choose the setting before you drag a sign or draw a line or curve.

Connect the Dots Mode  
This is for drawing smooth curves.  When you click on this mode, the cursor becomes a
small black square.  Click the mouse button at the spots where you want the apexes of
your curve to be.  (Apexes are the spots where the curve changes direction.)  A small
black square appears each place you click.  As soon as you drag the pointer into another
frame, it becomes an "OK" sign.

   Click the apexes of the curve, move into another frame
and an "OK" sign appears.
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If you click the mouse button while you see the "OK" sign, the small black squares become
a smoothly curved line.

A line "connects the dots" after you click the mouse.
You can use this mode to draw irregular curves that extend over more than one frame, like
pas de chat lines or high step lines.  Just depress the Shift key as you move the cursor into
another frame and your cursor will stay a small black square.  Keep dropping apexes until
the end of the curve, then move into another frames (one with no small black squares), see
"OK," then click.  When you move into the stave the cursor is still a square, so you can keep
on creating curves.

To edit a curve, be sure you have deselected connect the dots mode (click on its
highlighted icon).  Then select the curve you want to alter by depressing the Command key
( ) as you click on it or drag across it (if the curve is in one frame only).  Select Reshape
from the Signs menu (or type R) and the small black squares appear.  Drag the squares,
move into another frame, see "OK," then click.  

Once you have selected a curve, you can change it in a number of ways by selecting
operations from the Signs menu.  One very helpful operation is Mirror ( M), which gives
you a mirror image of the curve on the other side of the frame.  You guessed it–perfect for
symmetrical port de bras.  Try grouping a basic sign and a movement line, then select and
mirror it.  Don't worry about the dialogue box which is trying to tell you that MacBenesh can't
mirror a basic bitmapped sign–it is its own mirror image, so just click on "Continue" and
marvel at the results!  (Don't worry if you see a "phantom" image.  It will disappear when the
screen redraws itself.  Another insidious bug we are still hunting....)

More on editing curves in PART TWO.
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Trace Curve Modes  
These three modes are for freehand sketching of simple to complex curves.

We have preset four, seven and ten control vertices (apexes) which affect the inflections of
a curve.

"Freehand Mode": drag the mouse along any path.

When you click into one of these modes, the pointer becomes a crosshair (  ), and you can
draw by dragging the mouse in the path you want while holding down the mouse button.
When you release the mouse button, a smoothed curve appears.

With these modes you can create curves that extend through one or more frames.

You can edit trace curves the same way as connect the dots curves.
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Straight Line Mode  

Drag the mouse from the starting point to the ending point of your line.

This one is pretty basic.  Again, the pointer is a crosshair.  Place the crosshair at the spot on
the stave where you want your line to start.  Hold the button down and drag it to where you
want the line to end.  A straight line will be drawn ending at the spot where you let go of the
mouse button.  You can also click where you want the line to start ( an "x" appears), and click
again where you want it to end (a line appears).

This mode is useful for drawing horizontal, vertical, and sloped lines ("hairpin" brackets, for
example).  Although you can use this mode for slide lines or exclusion brackets, you can
also create them with the Locomotion and Phrasing menus.

The straight line mode works well across frames and will even expand and contract when
you add or delete a middle frame.  However, if you delete one of the end frames the
straight line will disappear altogether.  Go on try it!  You'll find the same thing happens in the
curve mode we explain next.
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Curve Mode 

This mode allows you to draw curved lines.  Place the cursor, which is again in the shape of
a crosshair  (  ), at the place where you want the curve to begin.  Now, hold down the
mouse button and drag it to the right or left until the curve is the right length.  Now drag the
mouse up or down, until the curve is the right height.  Let go of the mouse button when the
curve you want it drawn.  As with the straight line mode, you can also click where you want
the curve to begin (an "x" appears) and end, but remember that your second click has to
be above or below the "x" to let MacBenesh know how high or deep the curve should be.

Here you see three curves: a legato line above the stave, and two curved slide lines below
the stave (one curved upward and one curved downward).  To make sure that the two
curves appear continuous,  make sure you start the second curve exactly where the first
one ends: position the crosshair on the end of the first curve (the very centre of the crosshair
will disappear), then click or drag.

Dragging the mouse to the right for length, and up or down for height of curve.

Curved slide lines and legato lines can also be made with the Locomotion and Phrasing
menus.  

You will notice that the resulting curve has gaps and is also jagged.  Do not despair.  The
bad news is that we can't smooth the jaggies when the curve is displayed on the screen,
but the good news is that we can smooth the jaggies when the curve is printed on the
LaserWriter.

You'll notice a greyed box beside the curve mode icon.  It's shaded because it isn't yet
ready to use.  Eventually this "portion of an arc" mode will let you draw part of a circle,
helpful for things like curved travel, surfacing and group work.
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THE DISPLAY MODES

In addition to Pull Down and Pop Up menus, Display Modes let you view the stave in
different ways to make it easier to create your score.  Any combination of these modes can
be "on" or "off" at any time while you are editing your score.  Your printed file is not affected
at all by these modes.  Only the way it looks on the screen is different.  

MAGNIFY MODE

When the "Magnify Mode" box is highlighted, the stave appears magnified.

When you click into this mode, the frames are magnified.  This mode is especially useful for
precise placement of signs, and for "Connect the Dots" Mode.  
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WINDOW DISPLAY MODE

The screen on a MacPlus is not as wide as a letter size piece of paper.  The window in
which you view your dance score simply shows the piece of the document that happens to
fit into the window width.  You can change the size of a score window by dragging the icon (

 ) at the bottom right, where the vertical and horizontal scroll bars meet.

When you click into Window Display Mode, the frames "wrap" around, to display the score
in the width of your window.

Current models, like the Mac II, have screens big enough to show a full page width.  With a
big screen, you probably won't need this mode unless you choose to work with smaller
windows when you have several documents open.
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DOTTED FRAME BOUNDARY MODE

Dotted Frame Boundary Mode is automatically "on," until you switch it "off."

This is the default mode.  It simply means that when you open MacBenesh and start
adding frames, the stave is displayed with a dotted line separating each frame.  This helps
you keep track of where one frame ends, and another begins.

Working in this mode makes it easier for you to place signs like bar lines and repeat signs
near the edge of a frame.  Sometimes a sign, a turn sign for instance, may appear to be
between frames.  But there is no such place as "between frames" in MacBenesh.  Benesh
signs that show body position should be placed within the rectangular bounding box of a
frame, while certain transitional information (like turns, travel, and location signs) may be
placed in the frame-edge area.  There are a few good reasons for this.  MacBenesh
"stores" a sign with one particular frame: when a frame is cut or copied, all its frame-edge
signs are cut and copied too (this doesn't apply to multi-frame signs like Phrasing bows and
Locomotion lines).  And when a frame comes at the end of a stave, any signs in its right
frame edge stay on that stave--not somewhere "in limbo" between one stave and the
next!

A few tips for the novice: make sure you are in Dotted Frame Boundary Mode when you
are adding any signs that should "line up" with the edges of frames.  Phrasing bows in
particular should start at the very left of the frame where the phrase starts, and end at the
very right of the frame where the phrase ends.  If you haven't started and ended these
bows accurately, you'll see unwanted spaces between adjacent Phrasing bows when the
program spreads frames to fill the stave width.
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DOTTED CENTRE LINE MODE

Dotted centre line mode with default dotted frame boundary mode.

This mode displays the stave with a dotted vertical line running through the centre of each
frame.  It is especially useful for placing signs accurately within a frame.

Some notators like to turn this mode "on" immediately before they begin to create a score.

A LITTLE NOTE:

If you skipped the sections on saving and printing, or any other
parts of the manual, make sure you go back to them before you
finish.
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CONGRATS!

You did it!

You are now one of the select few who have been indoctrinated into "The Wonderful World
of MacBenesh."  Now it's up to you to bring your knowledge to the dance studios of the
world.

Don't worry if you get confused once in awhile, or make some mistakes.  Remember that
not only are you learning how to use MacBenesh, but you are also becoming familiar with a
whole new way of using computers.  Don't be afraid to ask people questions, and to look
things up in your manual every once in awhile.  There is more information on the trickier
menus and features in Part Two of this manual, and on Mac features in general in the
manuals that came with your computer.  With a little more practice, you'll be creating these
scores like a pro!

We hope you enjoyed this little tour of MacBenesh.  Remember that those hardworking
MacBenesh folk (we kept mentioning) are still busily searching out and destroying all those
nasty little bugs that keep infesting the program, causing that infuriating "bomb" to pop up
on your screen and end your session with a bang.

We need your help!  If MacBenesh does unexpected things, write (c/o Dance Dept.,
University of Waterloo, Waterloo, Ontario, N2L 3G1) and tell us what you were doing and
what happened.  We'll alert our exterminators, in the hopes of making the next version
bug-free (we can dream, can't we?).  

Good luck and happy scoring.

PART TWO:PART TWO:
ADDITIONAL INFORMATIONADDITIONAL INFORMATION
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FORMATTING IN MACBENESH

A MacBenesh file is a continuous string of Benesh notation frames.  On the
screen, there are 24 pixels (24p) on either side of the dotted centre line of each frame:
49p constitute the "in-frame" area of each newly added frame.  When displayed on
the screen or printed, these frames are automatically "wrapped" from one stave line to
the next, and evenly spaced out to fill the specified stave width.  To do this,
MacBenesh "stacks" frames side by side until the specified stave width is exceeded.
It then "bumps" the last frame to the next stave line, and adds equal "padding" to both
sides of all preceding frames in the "frame-edges," to distribute frames evenly along
that stave line.

 All points along a stave are therefore considered either in-frame or frame-
edge.
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Selected Unformatted Frames: screen display

Unformatted Frames: LaserWriter printout

An empty, Unformatted frame is 16 mm. wide when first added to the stave.
This is shown by the rectangular boundary which surrounds the unformatted frame
when it is Added or Selected.

The semantics of Benesh notation define where a given sign can be placed.
Signs which describe the configuration of body parts (we call them Body Signs) can
only be placed in-frame.  Signs in the following menus are considered Body Signs:
Head/Torso, Limbs, Two Feet Together, Contacts, Support, Supported, Supporting,
Wrists, Hop.  If a Body Sign is placed in a frame-edge area (i.e., outside the
rectangular boundary), the rectangle automatically expands to contain the sign.
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Selected Formatted Frames: screen display

Formatted Frames: LaserWriter printout

When a selected frame is Formatted, the boundary shrinks to contain the Body
Sign farthest from the centre line of that frame.  The minimum width of a frame is 8 mm.

Certain signs may be placed at the frame-edge without affecting the width of a
frame (i.e, without causing the bounding rectangle to automatically expand to contain
them).  These relate to Musical Scoring and Staging, and are found in the following
menus: Numerals, Bar Lines, Repeat Signs, Direction, Direction/Turn, Location, and
Travel.  All frame-edge signs are associated with one frame only: when you Cut,
Copy, etc., a selected frame, all in-frame and frame-edge signs are cut, copied, etc..
(In the examples above, each turn sign is associated with the following frame; if each
had been positioned a bit to the left, it would have been associated with the previous
frame.)

Some signs, such as bar lines and repeat signs, appear to be exactly between
frames but are actually at a frame-edge.  They are associated with one frame only:
either the preceding or the following frame.  When a bar line or an end repeat sign is
placed in the right frame-edge area, it snaps to the far right of that frame-edge.  When
a start repeat sign is placed in the left frame-edge area, it snaps to the far left of that
frame-edge.  (In the examples above, the start repeat sign is associated with the
second frame, and the end repeat sign with the fifth frame.)
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Certain signs extend through more than one frame.  The ends of multi-frame
signs are anchored to the frames in which they start and end, and the signs are
stretched or condensed as frames are Formatted/Unformatted or Added/Deleted.
These include signs from the Locomotion and Phrasing menus.

Because the DIY menu is used to create a number of sign types, DIY signs may
be either in-frame, frame-edge or multi-frame.  Further details can be found in the
directions for using the DIY menu.

A few other points of interest....

Signs which are always positioned at the centre of the frame automatically snap
to the centre line (e.g., Head/Torso menu signs; Rhythm menu signs, except the dot
for Grace notes).

A final double bar line signals the end of a stave line: no "padding" is added
around preceding frames on that stave line, and the following frame is added on the
next stave line.

The No Padding command found in the Frames menu can be used to remove
all padding automatically added around selected frames, if there are no signs in the
frame edge (excluding bar lines).  When No Padding is selected, the stave width is
equal to the widths of all frames in a stave and is not adjusted to fill the page width less
margins.  At present, No Padding does not affect the width of a frame when it is
copied.  To restore the automatic adjustment of frame-edge area to selected frames,
select the Re-Pad command from the Frames menu.

A NOTE ABOUT TEXTRECORDS AND FORMATTING

(see Adding Text to Your Score)

A text string is "anchored" at its insertion point to a fixed point in a frame.  That insertion
point remains fixed as the string is edited, and as frames are Formatted/Unformatted or
Added/Deleted.

When a frame is Cut/Copied, a text string with its insertion point within that frame is also
Cut/Copied.
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STEP-BY-STEP THROUGH SOME MENUS

Do It Yourself menu (  )

The Do It Yourself menu (DIY) allows you to select or create signs which you cannot
find in other menus.

1. Open the menu.
2. Select a line thickness or dotted line setting, if needed.
3. Drag the sign you want onto the stave.

or
4. Create the sign you want right on the stave.
5. Edit the sign, if needed.

Simple signs can be created with STEPS 3 and 4.
For more detailed explanations, read on.

STEP 1

Click on the DIY icon (  ) in the kit bar.
Drag the menu anywhere on the screen.
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STEP 2

The default setting  allows you to create lines the same thickness as
movement lines.  If thinner or thicker lines are not needed, skip to STEP 3.

1. To select a thickness or dotted line setting,
click the appropriate mode or modes:   

i. Thinnest (1/600"): thickness of stave lines
ii. Middle (1/300"): thickness of movement lines
iii. Thickest (1/150"): thickness of basic signs
iv. Dotted line: affects i. - iii.

Note:  All DIY signs are displayed at 1 pixel thickness on a regular Mac screen.  They are printed 1
pixel thick (1/72") on an ImageWriter Printer.  On screen, all lines appear to have the same thickness
in the regular display modes.  In Magnify mode, middle and thinnest lines (i. and ii.) appear thinner
than Thickest lines.  Printouts from higher resolution devices will show thinner lines.

2. To deselect a selected line thickness mode, click on another line thickness
icon.

3. To deselect dotted line mode, click on its highlighted icon.

STEP 3

Drag the sign you want onto the stave.
You can drag a predefined shape, line or spline:

a) Predefined shape:

1. Select a mode, if needed.

white  (default):

transparent  :

or black  :

2. Drag the shape onto the stave: small circle ( ) ,* larger circle ( ),
small square ( ), larger square ( ), diamond ( ), triangle ( ).

*The small circle looks like a square on screen, but prints as a circle.

b) Predefined line or spline:

1. Drag the sign onto the stave.
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STEP 4

Create the sign you want right on the stave.
First select a mode, then create a spline, line or curve:

1. Select a mode:

i. Connect the dots mode:

ii. Trace curve modes (3):

iii. Straight line mode:

iv. Curve mode (portion of an oval):

v. Portion of a circle:
(not yet implemented)

2. Create a spline, line or curve:

i. Connect the dots mode  .

Use this mode to create spline curves with as many curvatures as
needed.

When this mode is selected  , the cursor becomes a black square
control vertex (c.v.) in a frame.

To define the shape of the spline, position the cursor in a frame, and click
to "drop" any number of c.v.'s within that frame.  Then move the cursor
out of the frame until you see the "OK" icon, and click.  A curve connects
the c.v.'s.

To create a spline extending beyond the initial frame, depress the Shift
key as the cursor enters a new frame, and continue to drop c.v.'s.
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ii. Trace curve modes (3) .

Use these modes to create simple to more complex spline curves (i.e.,
splines with 4, 7 or 10 control vertices).

When any of these modes is selected  , the cursor
becomes a cross-hair in a frame.

To define the shape of the spline, position the cross-hair cursor in a
frame, depress the mouse button and wait for a second, drag the cursor
slowly along the desired path, and release the button at the curve's end.
Note that the most complex trace curve mode (far right) fits a curve with
10 c.v.'s; the next mode, 7; and the next, 4.

This mode creates a spline which can extend through one or more
frames.

iii. Straight line mode  .

Use this mode to create a straight horizontal, vertical or sloped line.
When this mode is selected  , the cursor becomes a cross-hair in a
frame.

To define the length and slope of the straight line, you can either a) click
at its start and end, or b) drag the cursor.

a) Position the cursor at the start of the line, click (an "x" appears), move
the cursor (sideways and/or up/down), and click where you want the
line to end.  A straight line appears.

or

b) Position the cross-hair cursor in a frame, depress the mouse button,
drag the cursor (sideways or up/down) and release the mouse
button at the line's end.

This mode creates a line which can extend through one or more frames.
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iv. Curve mode (portion of an oval)  .

Use this mode to create elongated arcs.
When this mode is selected  , the cursor becomes a cross-hair in a
frame.

To create elongated arcs, you can either a) click at the start and end of
the arc you want to create, or b) drag the cursor to define its size.

a) Position the cross-hair cursor in a frame, click (an "x" appears), move
the cursor sideways and up/down, and click at the desired height
above/below where you want the arc to end.  An elongated arc
appears.

or

b) Position the cross-hair cursor in a frame, depress the mouse button
at the start, drag the cursor sideways and up/down, and release the
button where you want it to end.

This mode creates an elongated arc which can extend through one or
more frames.

v. Portion of a circle   (not yet implemented).
This mode will be used to create a portion of a circle's circumference.

Note: To deselect any of these modes, click on the highlighted (darkened)
icon.  The icon becomes unhighlighted, and the cursor becomes a thin arrow in
a frame.

WARNING: IF THE LINE, SPLINE OR CURVE APPEARS
ERRATICALLY OVER MORE THAN ONE STAVE AS YOU ARE
DRAGGING, YOUR HAND MAY HAVE WANDERED TOO FAR UP
OR DOWN, INTO AN ADJACENT STAVE.  DO NOT RELEASE THE
MOUSE BUTTON.  JUST SLOWLY MOVE YOUR HAND UP OR
DOWN UNTIL THE DESIRED LINE, SPLINE, OR CURVE APPEARS.
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STEP 5

To edit a shape, line, spline or curve.

1. Select the sign:

i. Depress the Command key ( ) while clicking on the sign or dragging to
create a dashed rectangular bounding box around the sign (or signs).  A
selected sign twinkles.

ii. To extend the selection, depress the Shift key, then click or drag on a new
sign or signs in the same frame.
Note: signs cannot be selected simultaneously in multiple frames.

2. Select the appropriate option from the Signs menu.

i. Reshape ( R): to alter the shape (i.e., curvature) of a spline.  Drag
each c.v. until the desired shape appears, move the cursor out of the
frame containing the spline ("OK" appears), and click.

ii. Resize ( E): to elongate (i.e., change the height and/or width) of a
sign.  Drag the c.v. at the centre side of the bounding box to change
the sign's width; at the centre top or bottom to change its height; or at a
corner to change both height and width.  To change the height and width
equally, depress the Shift key while dragging a corner c.v.  When the
desired shape appears, move the cursor out of the frame ("OK"
appears), and click.

iii. Group ( G): to treat the selected signs as one.
(Note: signs that extend through more than one frame cannot be
grouped.)

iv. Ungroup: to ungroup a previouslygrouped selection.

v. Mirror ( M): to laterally flip a copy of the selection and position it on
the other side of the frame, equidistant to its centre line.

vi. Flip Lateral: to redraw the selection flipped left/right.

vii. Flip Horizontal: to redraw the selection flipped upside down.

viii. Rotate: to redraw the selection rotated 90° clockwise.

ix. Move 1 Pixel Up: to move a selected sign(s) 1 pixel up.  This can
also be done via the arrow key (  ).

x. Move 1 Pixel Down: to move a selected sign(s) 1 pixel down.  This
can also be done via the arrow key (  ).

xi. Move 1 Pixel Left: to move a selected sign(s) 1 pixel left.  This can
also be done via the arrow key ( ).
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xii. Move 1 Pixel Right: to move a selected sign(s) 1 pixel right.  This
can also be done via the arrow key ( ).

Note:
a. If a selected sign or signs cannot be edited in the mode selected, a

dialogue box appears allowing the user to continue or to cancel the
operation.

b. A sign stays selected (twinkles) after each operation so that further
operations can be performed.  To deselect a selected sign, click
anywhere off that sign.

c. When a sign is resized, reshaped or mirrored, a "phantom" sign may
appear.  It should disappear the next time the screen redraws itself.

Formatting and DIY Signs

1. When a DIY sign is placed within the bounding rectangle of a frame, i.e., in-
frame, and the frame is formatted, the frame will shrink to contain the sign.

2. When a DIY sign is placed outside the bounding rectangle of a frame, i.e.,
frame-edge, the frame-edge will contain the sign.

3. When a DIY sign extends from one frame to another, i.e., multi-frame, its far left
end and its far right end will stay anchored to the respective frame.  As frames are
formatted/unformatted or added/deleted, the DIY sign will automatically
stretch/shrink.

4. A DIY sign in a frame or frame-edge will be cut/copied with its frame.  A multi-
frame DIY sign will be cut/copied only when its start and end frames are
selected.
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Locomotion menu (  )

The Locomotion menu allows you to create step, jump, and slide lines.

1. Open the menu.
2. Select skimmed mode for jumps and slides, if needed.
3. Select a qualification mode (forward/back/diagonal), if needed.
4. Select a Locomotion mode: step, jump, or slide.
5. Create the line on the stave.
6. Edit the line, if needed.

Basic lines can be created with STEPS 4 and 5.
For more detailed explanations, read on.

STEP 1

Click on the Locomotion icon (  ) in the kit bar.
Drag the menu anywhere on the screen.

STEP 2

The default setting allows you to create step lines, and unskimmed jump and slide
lines.  If skims are not needed, skip to STEP 3.
1. To select Skim mode for jumps and slides, click  :

The Skim icon will be highlighted, and the jump and slide line mode boxes will
show skimmed jumps and slides.

2. To deselect Skim mode, click on the highlighted mode box.
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STEP 3

The default setting allows you to create unqualified step, jump, and slide lines.  If
qualifications are not needed, skip to STEP 4.

1. To select a qualification mode, click on one of six mode boxes:
i. forward diagonal left:
ii. forward:
iii. forward diagonal right:
iv. backward diagonal left:
v. backward:
vi. backward diagonal right:

The qualification mode box will be highlighted, and the appropriate locomotion
line mode box will show the qualification you selected.

When you create a Locomotion line (see STEP 5), the qualification will
automatically appear at the centre of the line you create for forward, backward,
and forward diagonal lines.  It will appear to the left of centre for backward
diagonal left, and to the right of centre for backward diagonal right.  As frames
are formatted/unformatted and added/deleted, the Locomotion line will
stretch/shrink, but the qualification will maintain its proportional placement on the
line.  If you want to manually change the placement of the qualification, see
STEP 6.

2. To deselect a qualification, click on the highlighted mode box, or select another
mode box.

STEP 4

1. Select a type of Locomotion line, i.e. steps, jumps or slides:

i. Normal Steps: to create a horizontal step line:
The attachment slants as needed for steps that join to the:

far side (for steps left): 

centre (for steps forward/in place/back):  

near side (for steps right): 

ii. Stepping from a lifted foot: to create an obliquely curved step line

Note: For irregular step lines, use the connect the dots or
trace curve modes in the DIY menu.
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iii. Jumps:

The attachment slants as needed for jumps that join to the:

far side (for jumps left):

centre (for jumps forward/in place/back):

near side (for jumps right):

iv. Straight Slides: 
to create horizontal lines indicating a straight slide
left, forward/back, right 

v. Upwardly Curved Slides:
to create the upper portion of an arc indicating
a circular slide performed in front of the body

vi. Downwardly Curved Slides:
to create the lower portion of an arc indicating
a circular slide performed behind the body

Note re iv.-vi.: Since slide lines do not attach to a basic sign, there is no need to vary the
slant of attachment.  The slide line ends below the appropriate point on the basic sign to
specify travel left (far side), forward/back (centre) or right (near side).

2. To deselect a Locomotion line mode, click on the highlighted icon, or select
another mode.

Note: When a Locomotion mode is selected, the cursor is a cross-hair on the stave; when
deselected, the cursor is an arrow.

STEP 5

Create the line on the stave by a) two clicks, or b) dragging.

a) Two clicks:
To define the locomotion line, position the cursor in a frame, and click where
you want the line to start (an "x" appears), then move the cursor, and click
where you want the line to end (a locomotion line appears).  The width of
the two clicks defines the start and end of the line.  Using the two click
method, you can define the height/depth as follows:

i.-ii. For steps, the height of the line is defined by the height of the first
click.

iii. For jumps, the depth of the line is predefined at a set distance
below the stave.
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iv.-vi. For slides, the distance below the stave is defined by the height
of the first click.  For circular slides the height/depth of the curve is
defined by the height/depth of the second click.

or
b) Dragging:

To define the shape of the locomotion line, position the cursor where you
want the line to start, depress the mouse button and drag the cursor
sideways and up or down, then release the button where you want the line
to end.

WARNING: IF THE LINE, SPLINE OR CURVE APPEARS ERRATICALLY OVER MORE THAN
ONE STAVE AS YOU ARE DRAGGING, YOUR HAND MAY HAVE WANDERED TOO FAR UP
OR DOWN, INTO AN ADJACENT STAVE.  DO NOT RELEASE THE MOUSE BUTTON.  JUST
SLOWLY MOVE YOUR HAND UP OR DOWN UNTIL THE DESIRED LINE, SPLINE, OR CURVE
APPEARS.

STEP 6

1. If you want to edit a Locomotion line:

1. Select the line:

Depress the Command key ( ) while clicking on the line.
A selected line twinkles.

2. Select the appropriate option from the Signs menu.

i. Reshape ( R): to alter the shape (i.e., curvature) of a spline.  Drag
each c.v. until the desired shape appears, move the cursor out of the
frame containing the spline ("OK" appears), and click.

ii. Resize ( E): to elongate (i.e., change the height and/or width) of a
sign.  Drag the c.v. at the centre side of the bounding box to change
the sign's width; at the centre top or bottom to change its height; or at a
corner to change both height and width.  To change the height and
width equally, depress the Shift key while dragging a corner c.v.
When the desired shape appears, move the cursor out of the frame
("OK" appears), and click.

Notes:
a. Locomotion lines can be edited in the same way as DIY signs.  Note that Group, Mirror,

Flip and Rotate apply to single-frame signs only.  If a selected Locomotion line cannot
be edited in the mode selected, a dialogue box appears allowing the user to continue
or to cancel the operation.

b. A  Locomotion line stays selected (twinkles) after each operation so that further
operations can be performed.  To deselect a selected line, click anywhere off that
line.

2. Eventually it may be possible to manually change the placement of a
qualification on a Locomotion line (depress the Shift key, drag the qualification
left or right, and release when it is repositioned correctly).
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Phrasing menu (  )

The Phrasing menu allows you to create  or drag various types of bows and
phrasing indications.

1. Open the menu.
2. Select a mode for creating a bow or bracket.
3. Create the shape on the stave.
4. Edit it, if needed.

or
5. Drag a sign onto the stave.

Bows and brackets can be created with STEPS 2 and 3,
or dragged with STEP 5.

For more detailed explanations, read on.

STEP 1

Click on the Phrasing icon (  ) in the kit bar.
Drag the menu anywhere on the screen.

STEP 2

To select a bow or bracket mode, click on one of the boxes:

legato line

multiple frame bracket

section or canon

exclusion bracket or start of section

start duration bracket

start of a phrase

end of a section

end duration bracket

end of a phrase
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When a mode is selected, the mode box is highlighted (e.g.,  ) and the
cursor becomes a cross-hair.  To deselect a mode, click on the highlighted box
or select another mode.

STEP 3

Create the bow or bracket on the stave by a) two clicks, or b) dragging.

a) Two clicks
To define the shape, position the cursor in a frame, and click where you
want it to start (an "x" appears).  Move the cursor upward and to the right
to show how wide and high you want the shape, then click again (a shape
appears).

a) Dragging
To define the shape, position the cursor where you want it to start, depress
the mouse button and drag the cursor upward and to the right, then release
the button where you want the line to end.  This method allows you to see
the shape as you are creating it.

WARNING: IF THE SHAPE APPEARS ERRATICALLY OVER MORE THAN ONE
STAVE AS YOU ARE DRAGGING, YOUR HAND MAY HAVE WANDERED TOO FAR
UP OR DOWN, INTO AN ADJACENT STAVE.  DO NOT RELEASE THE MOUSE
BUTTON.  JUST SLOWLY MOVE YOUR HAND UP OR DOWN UNTIL THE DESIRED
SHAPE APPEARS.

STEP 4

To edit a bow or bracket, select the sign, then select Resize from the Signs
menu, or type E.

STEP 5

Drag any of the following signs onto the stave:
single frame exclusion bracket
start phrase indication
end phrase indication
indication of continuity
(may be use between start and end indications)

Eventually, these signs will be editable.
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Counts menu (  )

The Counts menu allows you to create signs for musical counts, dancers counts and
specifically titled sections.

1. Open the menu.
2. Select a circular or square shape, if needed.
3. Select superscript for the numerals, if needed.
4. Select lowercase for the letters, if needed.
5. Click in the box for each numeral, letter, etc. you want.
6. Drag the sign(s) onto the stave.

Simple signs can be created with STEPS 2, 5 and 6.
For more detailed explanations, read on.

STEP 1

Click on the Counts icon (  ) in the kit bar.
Drag the menu anywhere on the screen.

STEP 2

To select a circular or square shape, if needed, click on one of the following
shapes:

The mode box is highlighted, and the selected shape appears at the top of
the menu.

If no shape is selected, the numerals, letters, etc. will appear unframed.

To deselect a selected shape, click on the highlighted mode box.

STEP 3
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To select superscript for numerals, if needed, click on

 .
A superscript dash and numerals are displayed.
To deselect superscript, click on 

 .
A plain dash and numerals are displayed.

STEP 4

To select lowercase letters, if needed, click on

 .
Lowercase letters are displayed.
To deselect lowercase letters, click on 

 .
Uppercase letters are displayed.

STEP 5

To "type" letters, numerals or dashes, click on the boxes in the order you
want.  Each sign you click appears at the top of the menu inside the shape
you specified (see STEP 2).  To add a space, click on the empty box to the
left of the dash.  As more signs are added, the shape expands to contain
them.
To erase the last sign you typed, click on the eraser icon .   To erase all
signs, hold down the Shift key as you click on the eraser.

STEP 6

To position the sign(s) on the stave, drag it from the top of the menu to the
position desired.  It is automatically grouped, i.e., considered as a single sign.

Eventally, it will be possible to edit the individual signs in the group as you
would any group of signs (see DIY menu).
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Surfacing menu (  )

The Surfacing menu allows you to create signs for Body Zoning and Surfacing.

1. Open the menu.
2. Select the setting for upper/lower surface, if needed.
3. Click in the box for each tick, line, dot, letter or numeral you want.
4. Drag the sign(s) onto the stave.

Simple signs can be created with STEPS 3 and 4.
For more detailed explanations, read on.

STEP 1

Click on the Surfacing icon (  ) in the kit bar.
Drag the menu anywhere on the screen.
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STEP 2
The default setting  allows you to create signs for the body surfaces
displayed above.  If upper/lower surfaces are not needed, skip to STEP 3.

To select the setting for upper/lower surfaces, click on  .
The appropriate signs are displayed:

Note: Not all of these signs are semantically meaningful at present.  They are included in
anticipation of theoretical refinements under consideration at The Benesh Institute.

To deselect the setting for upper/lower surfaces, click on  .
The original signs are displayed.

STEP 3

To "type" letters, numerals, ticks, etc., click on the boxes in the order you
want.  Each sign you click appears inside the shapes at the top of the menu
(see STEP 2), and also "unframed" at the centre.  To add an empty space
click on the empty box to the right of the eraser.  As more signs are added,
the shapes expand to contain them.

To erase the last sign you typed, click on the eraser icon  .    To erase all
signs, hold down the Shift key as you click on the eraser.

STEP 4

To position the sign(s) on the stave, drag it from the top of the menu to the
position desired.  It is automatically grouped, i.e., considered as a single sign.

Eventually it will be possibe to edit the individual signs in the group as you
would any group of signs (see DIY menu).
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ADDING TEXT TO YOUR SCORE

Text can be added to the Body of the score, and in Titles, Headers and Footers
(THF).

Text in the Body of the Score

STEP 1

To add text:

i. Select FreeText from the Document menu ( T).  The cursor becoms and I-
beam ( ).

ii. Select an insertion point on the stave (it can be in-frame or at a frame-edge).
A flashing vertical line appears.

iii. Type a text string (which we call a TextRecord).
iv. Select another insertion point and type another text string, as needed.
v. Deselect FreeText (via the Document menu or T) and return to creating

stave notation; or select Close TextRecord, Title, Header, or Footer, and
continue adding text.

The default settings for text in the body of the score are:
a) Font: Helvetica (see Font menu)
b) Size: 12 pt (see Font menu)
c) Style: Plain (see Font menu)
d) Alignment: Left (see Document menu)

These settings can be changed before a TextRecord is created, or by editing the
text string, as follows.

STEP 2

To edit a TextRecord:

i. Select FreeText from the Document menu ( T).
ii. Position the cursor over the TextRecord to be edited.
iii. Click once to select an insertion point, or twice to select a word; or drag across

the letter(s) to be edited.
iv. Type the changes, or change any of the default settings listed above (i.e.,

make other selections in the Document or Font menus).
v. Select another insertion point, etc.,  and edit another text string, as needed.
vi. Deselect FreeText (via the Document menu or T) or select Close

TextRecord, Title, Header, or Footer.

As described above, Align Left is the default alignment.  When a new alignment
is selected, the insertion point remains fixed and the TextRecord is repositioned
around it.

Note: Clear Text (Font menu) and Margin Text (Document menu) are always
shaded since they have not yet been implemented.

It will eventually be possible to make global changes to body of the score, as is
currently possible for Titles, Headers, and Footers..
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A NOTE ABOUT TEXTRECORDS AND FORMATTING (see Formatting in
MacBenesh)

A text string is "anchored" at its insertion point to a fixed position in a frame.  That
insertion point remains fixed as the string is edited, and as frames are
Formatted/Unformatted or Added/Deleted.  When a frame is Cut/Copied, a text string
whose insertion point is in that frame is also Cut/Copied.

Text in the Title, Header and Footer (THF)

Title is printed at the top of the first page of a file (below the Header, if any); Header
at the top of all pages; and Footer at the bottom of all pages.

These all work the same way.

STEP 1

To open a THF window, select Title, Header or Footer from the Document
menu.  FreeText is automatically selected and an I-beam ( ) appears.

STEP 2

To select an insertion point, position the cursor and click: a flashing vertical line
appears.  The height of your cursor determines the height of the insertion point.
The horizontal position of the insertion point (the left, centre, or right of the page) is
defined by the alignment selected.

The default settings for text in the THF windows are:

a) Font: New York (see Font menu)
b) Size: 12 pt (see Font menu)
c) Style: Plain (see Font menu)
d) Alignment: Left (see Document menu)



November 1991 The MacBenesh Manual Page 84

STEP 3

To create THF text,  you can either:

i. type a TextRecord, as described above,
or

ii. click on an icon in the bottom left of the THF window:

From left to right:

1. Current time (e.g., 4:13:26; time at which the icon was selected; the user
must reselect the icon to get a new "current time")

2. Current date (e.g., "Tuesday, November 5, 1991")

3. Page number (this is not fully implemented but will eventually be in arabic
or roman numerals; see Page Options)

4. Copyright notice (single click for the Benesh notice: "Benesh Movement
Notation © Rudolf Benesh, 1955.;" we will eventually implement a double
click for the MacBenesh notice, and triple click for the notator's notice.)

These are editable text strings (see below).

To start a new TextRecord, select Close TextRecord from the Document menu,
select a new insertion point, and continue as described in i. and ii..

STEP 4

You can edit THF text in an open THF window in the same way as in the body of
a score.  Select FreeText and continue as described above.
 
To make global changes to text in an open Title, Header, or Footer window:

i.  Select Change All from the Font menu: the item is "checked."
ii. Select a new Font, Size or Style: the change is made to all text in the current

Title, Header, or Footer window.
iii. Select Change All again to deselect it: the item is no longer "checked."

STEP 5

To move THF text vertically, deselect FreeText mode.  An arrow cursor appears.
Position it over the record, depress the mouse button (wait until the cursor
becomes the text string), and drag up or down.  Horizontal position is determined
by the Alignment selected (via the Document menu).

STEP 6

To close the THF window , deselect Title, Header or Footer, or click on the close
box in the upper left corner of the THF window.

SUMMARY OF OPERATIONS
                                                                                                                                                            

When You Want To Via a Menu Via the Keyboard
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Select an insertion point Double click at 
for adding a frame the desired point

Select a frame Double click at one
or frames side of a frame, then 

drag across the frame(s), or
press Shift and double click

at the other side of 
the frame(s)

Deselect an insertion Select another
point or a highlighted insertion point or
frame or frames another frame(s)

Select a sign Press , then click near
or signs in the same frame sign or drag across the

sign(s)

Select additional signs Press Shift- , then click
in the same frame near the additional
(i.e., extend a selection) sign or signs

Move a sign Select Move 1 Pixel Drag and release; or
or a group of signs from Signs menu select the sign(s) and

(to be implemented) use the arrow key to
move one pixel at a 

time

Move a sign that "snaps" Press Shift, then
to the centre line drag and release

Deselect a sign or signs Click anywhere off 
that sign or signs

Cut a selected frame Select Cut from Press X
Edit Menu
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When You Want To Via a Menu Via the Keyboard
                                                                                                                                                            

Copy a selected frame Select Copy from Press C
Edit Menu

Paste a cut or Select Paste from Press V
copied frame Edit Menu

Clear (i.e., delete) Select Clear from Press Delete (backspace)
a selected frame Edit Menu

Erase all signs in Select Erase from 
a selected frame Edit Menu

Add a frame Select Add from Press Space Bar
(immediately right of the insertion Frames Menu
point or highlighted frame)

Select All frames Select Select All Press A, or
in the file from Frames Menu double click at the start 

then drag across all frames or press Shift
and double click at the end

Format all selected Select Format Press F, or
frames from the Click in upper right

Frames Menu box of the unformatted
selected frame

Unformat all selected Select Unformat Press U, or
frames from the click in upper right

Frames Menu box of the formatted
 selected frame
Remove padding from Select No Padding
a selected frame(s) from the Frames Menu

Restore padding Select Re-Pad
to a selected frame(s) from the Frames Menu



November 1991 The MacBenesh Manual Page 87

SUMMARY OF COMMAND OPERATIONS
                                                                                                                                                            

Type or Via a When You
- Select Menu Want To

                                                                                                                                                            

A Select All Frames select all frames in a file

C Copy Edit copy  selected frame

E Resize Signs resize a selected sign(s)

F Format Frames format a selected frame(s)

G Group Signs group selected signs

M Mirror Signs mirror a selected sign(s)

N New File open an new file

O Open File open an old file

P Print File print an open file

Q Quit File quit the application

R Reshape Signs reshape a selected sign(s)

S Save File save an open file

T FreeText Document add text to a stave or THF

U Unformat Frames unformat a selected frame(s)

V Paste Edit paste a cut/copied frame

W Close File close an open file

X Cut Edit cut a selected frame

Z Edit not yet implemented
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INDEX

Add 3, 21, 27, 30, 35, 36, 38, 42, 54, 79,
81, 82, 86

Amount of turn 46
Benesh signs 7, 25, 31, 32, 45, 58
Body direction (See Direction)
Change direction (See Direction/Turn)
Close 7, 9, 11, 18, 20, 30, 33, 82, 84, 87
Copy 5, 13, 19, 36, 63, 70, 86, 87
Cut 13, 19, 20, 58, 63, 64, 71, 83, 85, 87
Deselect a sign 85
Direction 46, (See Direction/Turn), 48, 51,

63
Direction menu (See Direction)
Direction of turn 46
Direction sign 48
Direction/Turn 46, 63
DIY (See Do It Yourself), 25, 45, 50, 64,

65, 66, 71, 73, 75, 79, 81
Do It Yourself 3, 25, 31, 36, 38, 41, 45,

48, 50, 65
Draggable Signs 50
Draggable signs 46, 50, 51
Erase 12, 22, 38, 45, 79, 81, 86
Format 23, 24, 87
FreeText 28, 30, 82, 83, 84, 87
Group 22, 25, 45, 55, 70, 75, 79, 81, 85,

87
Head (See Head/Torso), 40, 41

Head/Torso 40, 41, 42, 62, 64

Legato line 55, 76
Mirror 25, 26, 52, 70, 71, 75, 87
Move a sign 26, 41, 85
New 6, 7, 9, 12, 16, 20, 21, 22, 30, 32, 33,

34, 48, 60, 67, 70, 82, 84, 87
No Padding 24, 64, 86
Open 9, 10, 12, 13, 20, 32, 33, 36, 40, 51,

57, 58, 65, 76, 78, 80, 83, 84, 87
Paste 13, 19, 20, 86, 87
Print 2, 11, 13, 14, 17, 51, 87
Quit 18, 20, 87
Re-Pad 24, 64, 86
Remove padding 86
Reshape 25, 26, 52, 70, 75, 87
Resize 25, 49, 70, 75, 77, 87
Restore padding 86
Save 7, 11, 12, 13, 87
Select a frame 22, 37, 85
Select a sign 25, 85
Select additional signs 85
Select All 22, 86, 87
Select an insertion point 82, 83, 85
Static direction sign (See Direction)
Torso (See Head/Torso), 40, 41
Turn 40, (See Direction/Turn)
Turn sign 46, 58, 63
Undo 19
Unformat 24, 86, 87


